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Microsoft PowerPoint
•MS PowerPoint is an application software for 

creating slide show presentation and related items
•MS PowerPoint can create/ build

▫ Presentation Slides 
▫ Audience handout (handout document to audiences)
▫ Speaker’s Note (script for a speaker)
▫ Outline page (a page of outline to be presented)

204100 MS PowerPoint 3



MS PowerPoint 2007: Screen Layout
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Screen Layout — Quick Access 
Toolbar
•Contains often-used commands.

▫ You can press the downward arrow to customize the 
toolbar.
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Screen Layout — The Ribbon (1)

204100 MS PowerPoint 6

•Extra tabs can appear when you select an object



Screen Layout — MS Office Button
•For other version, it will be File menu instead.

•Open, Save, Print, Send

•New Presentation
▫ You can start a new presentation from 
Template

Themes

Blank Presentation
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Templates
•A PowerPoint template is a pattern or blueprint of a 

slide or group of slides
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Templates: Examples

Agendas Award certificates Brochures

Budgets Business cards Calendars

Content slides Contracts Databases

Design slides Diagrams Envelopes

Expense reports Fax sheets Flyers

Forms Gift certificates Greeting cards

Inventories Invitations Invoices

Labels Letters Lists

Memos Minutes Newsletters

Plans Planners Postcards

Purchase orders Receipts Reports

Resumes Schedules Schedules

Statements Stationary Time sheets
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Themes
•To give your presentations a designer-quality look 

— a look that includes one or more slide layouts 
with coordinating colors, a matching background, 
fonts, and effects, you'll want to apply a theme. 
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Themes
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Blank Presentation
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Open and save
• Open
 MS Office Button  Open  Select File

• Save
 MS Office Button  Save as  เลอืก version 

 Type in File Name  OK
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Different views in PowerPoint

•Creating or editing
▫ Normal view 

▫ Slide Sorter view

▫ Notes Page view

▫ Master views 204100 MS PowerPoint 14



• Add new slide : Home tap  New slide

• Or Press Ctrl-M

Adding New Slide
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• Normal
▫ For editing and creating new slides

• Slide Sorter
▫ See the ordering of slides

• Note Page
▫ Add notes to the slides

• Slide Show
▫ Show the presentation

Different views in PowerPoint
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Slide Master

•Used for:
▫ Make Changes to All Slides
▫ Adding and Changing Layout
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Note Master
To Close
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Home Tab
•Slide Layout

•Change Font Typeface and Size

•Alignment & Text Direction

•Drawing

•Editing
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Slide Layout
• On a slide, Define

▫ Containers

▫ Positioning

▫ Format 

• Can add your own on Slide 
Master
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Change Font Typeface and Size
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Change Text Color
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Alignment

•Home  alignment
▫ Align Left

▫ Center

▫ Align Right

▫ Justify
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Indentation & Paragraphs 

• Increase or Decrease Indentation to Lines of Text
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Text Direction
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• Change the direction of text
• Select the text, then go to Home Tab  Text Direction



Selecting Objects
•Click on the object you want to select

•Depending of type of objects, additional tabs will 
appear
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Formatting Objects

•Change the Appearance of 
Objects (text box, shapes, etc.)

•Can change:
▫ Objects’ Color (Shape Fill)

▫ Objects’ Outline

▫ Adding Effects to Objects
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Shape Fill

•Adding/Changing Fill Color of an 
Object

•Select the object, then go to
▫ Home Tab  Shape Fill
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Shape Outline

•Adding/Changing Outline of an 
Object
▫ Type of line
▫ Color
▫ Weight (width)

•Select the object, then go to
▫ Home Tab  Shape Outline
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Shape Effect

•Adding/Changing Effects to an 
Object, such as:
▫ Shadow

▫ Glow

•Select the object, then go to
▫ Home Tab  Shape Effects
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Quick Style
• Adding Styles (fill + outline + effects) to an Object quickly.
• Select the object, then go to

▫ Home Tab  Quick Styles
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Arrange

• Changing the Order of Objects
▫ Which one appear in front/in the back of others

• You can also group objects
• Select the object(s), then go to

▫ Home Tab  Arrange
▫ Then select the ordering/grouping
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The Insert Tab

•Table

•Picture

•Clip Art

•Photo Album

•Shapes

•Smart Art

•Chart

•Hyperlink

•Action
More details @ http://it.usu.edu/tutorials/use-the-insert-tab-in-powerpoint/
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Insert Table (1)
• Insert Tab  Table

▫ Select dimensions of cells then press Enter of 
Left Click

• Table Tools Tabs will appear

▫ Design

▫ Layout
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Insert Table (2)
•Design Tab is for changing the look (border, color)

• Layout Tab is for changing how cells/table are 
positioned
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Insert Picture
• Insert Tab  Picture

▫ Select the image you want

▫ Click Insert

•Format Tab (Picture Tools)
▫ Alter color, shapes, position, even which part will be shown 

(crop)
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Insert Clip Art
• Insert Tab  Clip Art

▫ Clip Art panel will appear

▫ Use keywords to search for clip arts
Type keywords under Search for:

Click Go

•Clip Arts are not available in later 
version
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Insert Shapes
• Insert Tab  Shapes

▫ Select the shape you want

▫ Then click-and-drag to draw it on the 
slide
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Insert SmartArt

•Premade combination of texts and shapes

• Insert Tab  SmartArt
•Select SmartArt

•Make changes as you’d like
▫ Type in Text

▫ Change Color and Layout
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Insert Chart
• Graphical Representation of 

Data (graph)
• Insert Tab  Chart

▫ Select Chart Type
▫ Type in Data on 

Spreadsheet
▫ Adjust Details

•Design, Layout and 
Format Tabs will appear
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Insert Text Objects

•Text Box
▫ Insert Tab  Text Box
▫ Click and Drag to position the text box

▫ Type in the Text
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Text Objects
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Add text
click text box drawing text box typing letter 

 

Add symbol
Click Symbol select symbol insert

• When you select a shape or a text object, Format tab (Drawing Tools) will appear



Adding Header and Footer
• Insert Tab  Header and Footer
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Links
•Hyperlink

▫ Create Link to web page, picture, e-mail, other slide
▫ Select object  Insert tab  Hyperlink

•Action
▫ Add the action to the object selected what will be 

happen when click or moving mouse cursor over it.
▫ Example.
▫ Select object  Insert tab  Action
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•Page Setup & Slide Orientation

•Themes

•Background

Design Tab

204100 MS PowerPoint 46



Theme
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• Theme
▫ Design  select  theme 

•To apply new colors to a theme:
▫ Click the Colors drop down arrow 
▫ Choose a color set or click Create 

New Theme Colors



Background
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• Background
• Design  Background styles



Slide Show
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Slide Slow (cont.)
• Custom Slide Show

▫ Show chosen slides and ordering
• Set Up (default) Slide Show

▫ Show Type
▫ Screen
▫ Custom Order

• Hide (current) Slide
• Record Narration 
• Rehearse Timing – Time your presentation
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Presenter’s View • Available in later versions of 
PowerPoint

• Appear on presenter’s 
screen

• Let you:
1. See next slide/animation.

2. See notes.

3. Control setting during 
presentation.

4. Select pointers/ see all 
slides/ etc. via screen 
menu. 51

1

2
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Animations Tab
•Slide Transition

▫ Animation when switching from one slide to the next

•Slide Animation
▫ Animation for objects
Entrance/Emphasis/Exit

•Animation Preview
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Slide Transition

▫ Slide transitions are the animation-like effects that 
occur in Slide Show view when you move from one 
slide to the next during an on-screen presentation. 
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Using Slide Transition
•Transition Effect

•Transition Sound

•Transition Speed

•Apply to All

204100 MS PowerPoint 54



Slide Animation
• Animation effects and sounds 

can add excitement to your 
presentations and help you 
emphasize key points while you 
deliver the slide show

• To Apply an Animation Effect
▫ Select the object 

▫ Click the Animations tab on the 
Ribbon 

▫ Click Custom Animation

▫ Click Add Effect

▫ Choose the appropriate effect
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Custom Animation
•Effect Options

▫ Effects

▫ Timing

•Ordering
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Animation Preview
•To preview the animation on a slide:

▫ Click the Preview button on the Animations tab 
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Printing Slides
•Handouts

•Notes pages

•Presentation

•Outline view
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Printing Slides

Note Page Outline View
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Steps to Create a Presentation
1. Plan your content

▫ Ask yourself:
What is the purpose of your presentation?

What message do you want to deliver?

▫ Write up the outline with all the necessary topics
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Steps to Create a Presentation
2. Add details to all topics

▫ Add important details to all topics. 

▫ Remove any unnecessary details

▫ Too much graphic/details can be distracting

▫ One topic per slide.
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Steps to Create a Presentation
3. Support the headline with graphic evidence

▫ support your points with graphic evidence.

▫ This can include photos, images, charts and 
diagrams.
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Steps to Create a Presentation
4. Fine Tuning

▫ Fonts

▫ Transition

▫ Animation

▫ Too much can be distracting
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Steps to Create a Presentation
5. Put details in the handouts

▫ The handouts should have the necessary details 
not included in the slides

▫ PowerPoint supports printing in different formats 
e.g. note pages, handouts
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Making Presentation
•Topic: Facts about Cat

•Length: 1 page
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Facts about Cats
•Scientific Name: felis catus

•Cats are carnivorous

•Young cats are called kitten

•Rub cat’s belly at your own risk!
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Facts about Cats – With Pictures!
• Scientific Name: felis catus

• Cats are carnivorous

• Young cats are called kitten

• Rub cat’s belly at your own 
risk!
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• Scientific Name: felis catus

• Cats are carnivorous

• Young cats are called kitten

• Rub cat’s belly at your own risk!
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Tree Kangaroo• b introduction

 The tree-kangaroos are marsupials of 
the genus Dendrolagus adapted for 
arboreal locomotion. They inhabit the 
tropical rainforests of New Guinea, 
far northeastern Queensland and 
some of the islands in the region. 
Most tree-kangaroos are considered 
threatened due to hunting and habitat 
destruction. Tree-kangaroos are the 
only true arboreal macropods.

 Description
 Tree-kangaroos have several adaptations to 

an arboreal life-style. Compared to 
terrestrial kangaroos, tree-kangaroos have 
longer and broader hind feet with longer, 
curved nails. They also have a sponge-like 
grip on their paws and soles of their feet. 
Tree-kangaroos have a much larger and 
pendulous tail than terrestrial kangaroos, 
giving them enhanced balance while moving 
about the trees. Like terrestrial kangaroos, 
tree-kangaroos do not sweat to cool their 
bodies, rather, they lick their forearms and 
allow the moisture to evaporate in an 
adaptive form of behavioural
thermoregulation.

Do and Don’t with PowerPoint slide

Avoid: Hard to 
read font/color

Avoid: Too much text
Should: List only 

main points

Should: 
Focus on one 

topic/slide

Source: Wikipedia
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